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Preface

This document describes how to install and configure the Sun Management Center

integration package for Tivoli systems. This manual assumes that the installation

and configuration will be performed by an experienced Tivoli administrator familiar

with the Sun Management Center product.

Tivoli TME provides good general network monitoring functionality, and the Sun

Management Center product provides excellent advanced capabilities and in-depth

information for monitoring Sun products. The integration of these two applications

provides Tivoli administrators with significant additional functionality to manage

networks containing Sun products. This product performs two functions: First, it

passes alarms from the Sun Management Center software to TEC (after appropriate

filtering and formatting); and second, it provides access to the Sun Management

Center Host Detail task library, thereby enabling Tivoli administrators to display the

Sun Management Center Host Details screen for the hostname selected in the Tivoli

event console.

Before You Read This Book

This manual assumes that the Tivoli environment has been correctly configured and

that the installation of the Sun Management Center adapter package will be

performed by an experienced Tivoli administrator. In particular, the Tivoli Logfile

Adapter software must be installed so that the appropriate adapter directories and

infrastructure exist. Refer to the Tivoli TME10 Enterprise Console Adapters Guide for

Tivoli-specific procedures.

This manual also assumes that the Sun Management Center Console, all Sun

Management Center-related .jar files, and the Sun Management Center-included

Java Runtime Environment (JRE) have been installed on the Tivoli server on which

the Sun Management Center adapter package will run. Refer to the Sun Management
Center 2.1 Software User’s Guide for instructions on installing this software.
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Using UNIX Commands

This document may not contain information about basic UNIX® commands or

procedures for shutting down the system, booting the system, or configuring

devices.

Refer to one or more of the following for this information:

■ Solaris Handbook for Sun Peripherals

■ AnswerBook2™ online documentation for the Solaris™ operating environment

■ Other software documentation that you received with your system

Typographic Conventions

TABLE P-1 Typographic Conventions

Typeface Meaning Examples

AaBbCc123 The names of commands, files,

and directories; on-screen

computer output

Edit your .login file.

Use ls -a to list all files.

% You have mail .

AaBbCc123 What you type, when

contrasted with on-screen

computer output

% su
Password:

AaBbCc123 Book titles, new words or terms,

words to be emphasized

Command-line variable; replace

with a real name or value

Read Chapter 6 in the User’s Guide.

These are called class options.

You must be superuser to do this.

To delete a file, type rm filename.
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Shell Prompts

Related Documentation

TABLE P-2 Shell Prompts

Shell Prompt

C shell machine_name%

C shell superuser machine_name#

Bourne shell and Korn shell $

Bourne shell and Korn shell superuser #

TABLE P-3 Related Documentation

Application Title Part Number

Sun Management Center

Installation

Sun Management Center 2.1 Software
User’s Guide

806-3166-10

Tivoli adapters TME10 Event Integration Facility User’s
Guide

Tivoli task libraries and

tasks

TME10 Framework User’s Guide

Tivoli BAROC file and

rules

TME10 Enterprise Console Rule Builder’s
Guide

Tivoli Console and tasks TME10 Enterprise Console User’s Guide
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Ordering Sun Documentation

Fatbrain.com, an Internet professional bookstore, stocks select product

documentation from Sun Microsystems, Inc.

For a list of documents and how to order them, visit the Sun Documentation Center

on Fatbrain.com at:

http://www.fatbrain.com/documentation/sun

Sun Documentation on the Web
The docs.sun.com sm web site enables you to access Sun technical documentation

on the Web. You can browse the docs.sun.com archive or search for a specific book

title or subject at:

http://docs.sun.com

Sun Welcomes Your Comments

We are interested in improving our documentation and welcome your comments

and suggestions. You can email your comments to us at:

docfeedback@sun.com

Please include the part number (806-2071-10) of your document in the subject line of

your email.
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CHAPTER 1

Installation

Adapter Package Overview

The name of the adapter package is: SUNWestia .

Tivoli Files

The rootdir for the Tivoli files is $BINDIR/TME/TEC/adapters ($BINDIR is

defined in /etc/Tivoli/setup_env.sh ).

■ tecad_symon.baroc , tecad_symon_conf , and tecad_symon.err are located

in rootdir/etc . These files are the typical necessary Tivoli adapter event class

definition, configuration, and error files.

■ tecad_symon and SMCTaskLib are located in rootdir/bin . tecad_symon is

the actual adapter file that needs to be run. SMCTaskLib is the task library

containing the Sun Management Center HostDetails launch task for the Tivoli

Console.

Java Support Files
■ /opt/SUNWsymon/SunMC-Tivoli/classes — contains .jar files.

■ /opt/SUNWsymon/SunMC-Tivoli/sbin — contains the following Bourne shell

scripts:

■ LaunchHDBean.sh — called from SMCTaskLib to pass required Sun

Management Center event parameters to LaunchHDBean.class .

■ SunMC_Tivoli — Bourne shell scripts to start and stop the adapters.
11



■ si-start.sh — Bourne shell script that sets the appropriate environment

variables and starts the SyMONInt application.

Documentation
■ PostScript and PDF versions of this document are located in

/opt/SUNWsymon/SunMC-Tivoli/doc .

Other Tivoli-related Installation Script Actions
■ The installation script adds the event server’s name to the tecad_symon.conf

file.

■ The script creates a Tivoli source group for Sun Management Center software.

■ The script complies and adds the Sun Management Center Task Library.

■ The script creates, complies, and loads a Sun Management Center rule base, then

provides you with the option of restarting the event server (restarting the event

server is required for the new rule base to be recognized).

Pre-Installation Tasks

Pre-Installation Checklist

You install the Sun Management Center Tivoli Integration Package by running the

installation script install.sh . Before running the script, check that the following

conditions are met:

■ TME Frame Work is installed.

■ TEC server is installed.

■ TEC Console is installed.

■ At least Sun Management Center’s console is installed.

■ Ensure that the C preprocessor cpp is installed in /usr/ccs/lib .

■ In Tivoli, that an administrator has been created with the TME Roles admin ,

senior , and super .
12 Sun Management Center-Tivoli TEC Adapter Installation Guide • November 1999



■ The Sun Management Center Console, and the Sun Management Center-included

Java Runtime Environment (JRE) are installed on the Tivoli server on which the

adapter will be run.

■ Sun Management Center server that you want to connect to is started.

■ Check that you are running Sun Management Center 2.1 software. The Sun

Management Center-Tivoli adapter is supported only for Sun Management

Center 2.1 software.

Limitations of the Adapter

The physical host must be a Sun system: the Sun Management Center server layer

runs only under the Solaris operating environment. You must size, configure, and

balance your system appropriately to satisfy performance and overall operation

requirements of both server layers. Consult the appropriate Sun Management Center

and Tivoli documentation for assistance.

▼ Preliminary Preparations

1. Start the Tivoli server.

2. Start the Sun Management Center server: become root, then enter the following
commands:

# cd /opt/SUNWsymon/sbin/

# ./es-start -A

3. Create an administrator at Tivoli’s desktop.

a. Start the Tivoli desktop:

# setenv DISPLAY ${hostname}:0.0

# . /etc/Tivoli/setup_env.sh

# tivoli &
Chapter 1 Installation 13



b. Select Administrators icon (FIGURE 1-1).

FIGURE 1-1 Select Administrators Icon
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c. Select the Create menu in the window (FIGURE 1-2), then locate the Create
Administrator window (FIGURE 1-3).

FIGURE 1-2 Select Create Menu
Chapter 1 Installation 15



d. Enter the appropriate information in the Administrator Name, User Login
Name, and Group Name fields.

FIGURE 1-3 Create Administrator

e. Select the Set TMR Roles button to obtain the Set TMR Roles window
(FIGURE 1-4). Select admin, senior, and super from Available Roles to Current
Roles. Then click Set or Set & Close to validate the settings.

FIGURE 1-4 Set TMR Roles
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f. Select Set Logins in the Create Administrators window (FIGURE 1-3) to obtain
the Set Login Names window (FIGURE 1-5). Type the login name in the text field
and press Return to enter (the login name will be displayed in the Current
Login Names window). You can also click on the Remove button to remove the
login names displayed in it. Select the Set or Set & Close button to validate the
Current Login Names.

FIGURE 1-5 Set Login Names

g. Select the Set Resource Rules and Set Notice Groups buttons in the Create
Administrators window (FIGURE 1-3) to set corresponding parameters.
Chapter 1 Installation 17



Installation Parameters Checklist

The installation script will prompt you for the following information before

installing the adapter package:

■ Tivoli adaptor port number: The default is port 2323, but if that port conflicts with

another application using that port, you can specify a different port when

prompted.

■ Tivoli Policy Region: The script will prompt you for the Tivoli Policy Region in

which the Sun Management Center Task Libraries should be created. The policy

region must already exist or the script will fail.

■ Tivoli Event Server: Do you wish to restart the Tivoli Event Server? Restarting the

Tivoli Event Server is required for the new Sun Management Center rule base to

be recognized by Tivoli. If you choose not to have the installation script restart the

server, you must restart the server manually before the integration will function

correctly.

Note – Be sure that the Tivoli Event Server restarts successfully and without errors.

If the Event Server doesn’t restart successfully, neither the adapter nor the

SyMONInt application can be started by the installation script, and these steps will

then need to be performed manually.

■ Tivoli adapter: Do you wish the installation script to start the Tivoli adapter? If

you answer “yes”, the adapter will be started by invoking the

$BINDIR/TME/TEC/adapters/bin/tecad_symon executable.

Note – If the Tivoli adapter does not start successfully, the SyMONInt application

cannot be started automatically and you will need to perform these steps manually.

■ SyMONInt startup application: Do you wish to start the SyMONInt startup

application? If you answer “yes” to the prompt, the script

/opt/SUNWsymon/SunMC-Tivoli/sbin/si-start.sh is run. This application

must be running in order for the integration to work correctly, so if you choose

not to have the installation script start the application, you must start the

application manually.

Note – You will need to restart the SyMONInt startup application after rebooting

(or if the process dies or is killed) by manually running si-start.sh .
18 Sun Management Center-Tivoli TEC Adapter Installation Guide • November 1999



Installation

The SUNWestia package can be installed during installation of the Sun Management

Center software, or at a later time. If you did not install SUNWestia during

installation of the Sun Management Center software, you will need to install the

package now.

▼ Installing the Adapter Package

1. Become root.

2. Change to the package directory.

3. Install the packages:

# pkgadd SUNWestia

Watch for error messages, particularly failures of Tivoli commands. Most errors are

likely to be permission-related. These is also the possibility of encountering Tivoli-

generated errors when compiling the task library or creating and compiling the rule

base. While installing, you will be asked some questions:

a. display name?

Enter hostname:0.0

b. port number?

The default port number is 2323.

c. region name?

Provide the name of an existing Tivoli region.

d. restart Event Server?

Enter “Y” to restart event server or “No” to refuse it.

e. restart Sun Management Center Adapter?

Enter “Y” to restart Sun Management Center Adapter or “No” to refuse it.

f. restart Java Application?

Enter “Y” to restart Java Application or “No” to refuse it.

During the installation process, the script performs the following actions:

■ Copies files from the SUNWestia package to

■ $BINDIR/TME/TEC/adapters
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■ /opt/SUNWsymon/SunMC-Tivoli

■ Adds the event server’s name to the

$BINDIR/TME/TEC/adapters/etc/tecad_symon.conf file.

■ Creates a Tivoli source group for Sun Management Center software.

■ Compiles and installs the Sun Management Center task library to the Tivoli

Region.

■ Creates, compiles, and loads the Sun Management Center rule base to Tivoli.

■ If the answers to restart Event Server?, restart SunMC Adapter?, or restart Java
Application? are “Y” , then the Event Server, Sun Management Center Adapter,

and Java Application will be restarted.

Uninstalling

▼ Uninstalling the Adapter

1. To uninstall, become root and run the following command:

# pkgrm SUNWestia

The script will remove any relevant files and stop any active processes.

▼ Deleting the Sun Management Center Task

Library

1. If Sun Management Center Task Library is not deleted, you can delete it manually
from the Tivoli Console. First, go to the appropriate Policy Region.

2. Select the SunMC Task Library icon.

3. Choose Edit->Delete.

Troubleshooting the Installation

The following suggestions may assist you if you encounter problems with the

installation:
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■ Make sure that Tivoli Framework and TEC server have been installed.

■ Make sure that the Sun Management Center Console and Sun Management

Center-included Java Runtime Environment (JRE) have been installed.

■ Make sure that the Tivoli Event Server is running.

■ Make sure that the Sun Management Center server is running.

■ Make sure that Region name you have specified exists in the Tivoli server.

■ Make sure that the C preprocessor cpp exists in /usr/ccs/lib .

Additional Help
■ Assistance with Tivoli problems may be found at:

http: //www.support.tivoli.com

■ The online Sun Management Center documentation may be found at:

http: //www.sun.com/sunmanagementcenter
Chapter 1 Installation 21
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CHAPTER 2

Using the Applications

This chapter describes how to start and use the TEC Adapter, the SyMONInt

Application, and the Tivoli task. Some troubleshooting suggestions are provided.

Starting the Applications

Both TEC Adapter and SyMONInt Application need to be running for this product

to function correctly. The applications can be started either together or separately.

Starting the TEC Adapter and SyMONInt

Application Together

Use the SunMC_Tivoli command to start TEC Adapter and SyMONInt Application

together. The command syntax is:

SunMC_Tivoli [ start | stop ] [ -c filename [ -u username ] ] | [ -h ]

If no parameters are specified, the SyMONInt GUI will start. The following

parameters are optional:

■ -c filename : read configuration parameters from filename to start the TEC Adapter

and the SyMONInt Application.

■ -u username : specify the username to be connected to Sun Management Center

server. The -u parameter may be specified only if the -c parameter has been

specified.

■ -h : print usage message for SunMC_Tivoli.
23



▼ Starting the TEC Adapter and SyMONInt Application
Together

1. Become root .

2. Move to the sbin directory:

# cd /opt/SUNWsymon/SunMC-Tivoli/sbin

3. Run the SunMC_Tivoli command:

# SunMC_Tivoli start

Starting the TEC Adapter and SyMONInt

Application separately

If you are starting the applications separately, the TEC Adapter should be started

before the SyMONInt Application is started.

The tecad_symon command opens a socket to the SyMONInt Application and

accepts Tivoli-ready event strings.

The SyMONInt application retrieves Sun Management Center events from a Sun

Management Center server (based on user login and filter input), maps some of the

fields into Tivoli equivalents, creates a Tivoli-ready event string and passes that

string to the tecad_symon Tivoli adapter.

▼ Starting the TEC Adapter

1. Set the Tivoli environment:

If you are running the Bourne shell, type

. /etc/Tivoli/setup_env.sh

If you are running the C shell, type

source /etc/Tivoli/setup_env.csh

2. Start the adapter with the following command:

# $BINDIR/TME/TEC/adapters/bin/tecad_symon -l \
$BINDIR/TME/TEC/adapters/etc/tecad_symon.conf \
-p Tivoli_adapter_port_number &
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▼ Starting the SyMONInt Application

1. Change to the /opt/SUNWsymon/SunMC-Tivoli/sbin directory.

2. Run si-start.sh to start the SyMONInt GUI. This script sets the appropriate
environment and invokes the SyMONInt.class , which displays the parameter-
entry window (FIGURE 2-1).

FIGURE 2-1 Sun Management Center-Tivoli Integration
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3. Enter information for the mandatory fields and whichever optional fields you
wish in the parameter-entry window.

4. Click the File->Save menu to display the File Dialog popup menu. Specify the
directory and file name in which to save the current configuration information.

5. Select the File->Start menu choice to connect to the Sun Management Center
server.

SyMONInt Startup Parameters

TABLE 2-1 lists the parameters for the Sun Management CenterIntegration window.

TABLE 2-1 SyMONInt Startup Parameters

Parameter
Mandatory/
Optional Description

Username/Password Mandatory Valid Sun Management Center

username and its corresponding

password

Sun Management Center

Server

Mandatory Hostname of the Sun Management

Center server from which you wish to

receive events

Tivoli Server Mandatory Hostname of the Tivoli server to which

you wish to send events

Tivoli Adapter Port

Number

Mandatory Port number for the Tivoli adapter’s

socket connection with the Sun

Management Center integration Java

application. The default is 2323, but if

you chose a different value at

installation time, you must enter that

new port number here.

Sun Management Center

Server RMI Port Number

Mandatory Port number at which the Sun

Management Center server receives

RMI connections. The default is 2099,

but if you chose a different value for

your Sun Management Center

configuration, you must enter that new

port number here.
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Note – If the “Domain to filter on” and “Hostname(s) to filter on” are set at the

same time, the parameter for “Domain to filter on” has higher priority.

Domain to filter on Optional If you only want to see Sun

Management Center events from a

specific Sun Management Center

domain, enter that domain name here.

The default is to receive events from all

Sun Management Center domains set

up on the specified Sun Management

Center server.

Hostname(s) to filter on Optional If you only want to see Sun

Management Center events originating

from a specific machine, enter those

hostnames here, separated by spaces.

The default is to receive events from all

machines monitored by the specified

Sun Management Center server.

Alarm State(s) to filter on Optional If you only want to see events in a

specific state (Open, Closed, Fixed),

check the appropriate boxes. The

default is to receive events in both

states.

Acknowledgement

State(s) to filter on

Optional If you wish to only see acknowledged

or unacknowledged events, check the

appropriate box. The default is to

receive events in both states.

Severity State(s) to filter

on

Optional If you wish to only see events with

specific Sun Management Center

severity states, check the appropriate

box(es) (refer to the Sun Management
Center2.1 Software User’s Guide for

additional information about Sun

Management Center’s severity levels).

The default is to receive events in all

severity states.

TABLE 2-1 SyMONInt Startup Parameters (Continued)

Parameter
Mandatory/
Optional Description
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Stopping the Applications

Use the SunMC_Tivoli command to stop TEC Adapter and SyMONInt Application

together.

▼ Stopping the TEC Adapter and SyMONInt

Applications

1. Become root.

2. Change to the /opt/SUNWsymon/SunMC-Tivoli/sbin directory.

3. Give the following command:

# SunMC_Tivoli stop

Application Tasks

▼ Viewing the Sun Management Center-Generated

Events

1. Start the Tivoli task.
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2. Double-click in the Administrator’s Event Console (FIGURE 2-2) to display the
Event Sources window(FIGURE 2-3).

FIGURE 2-2 Start Administrator’s Event Console
Chapter 2 Using the Applications 29



3. Select either the All or SunMC group choices for event viewing (FIGURE 2-3) to
display the Sun Management Center-generated events (FIGURE 2-4).

FIGURE 2-3 Select SunMC Group
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FIGURE 2-4 SunMC-Generated Events
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▼ Starting the Hostdetail Task

To view or manipulate the attributes and properties associated with the hosts

managed by the Sun Management Center software, run a TEC task to launch the

console window containing the host detail information.

1. Select a SunMC-generated event from the event list. Select Task->Execute on
Selected Event (FIGURE 2-4) to display the Tasks window FIGURE 2-5).

2. Double-click on SunMC Task Library, then Launch SunMC HostDetails
(FIGURE 2-5).

FIGURE 2-5 Launch SunMC HostDetails
32 Sun Management Center-Tivoli TEC Adapter Installation Guide • November 1999



3. In response to the prompt for a hostname on which you wish the Sun
Management Center windows to be displayed, enter the hostname and click
“Execute”. A scaled-down version of the Sun Management Center login screen
will appear (FIGURE 2-6).

FIGURE 2-6 Sun Management Center Login Window
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4. To display the Host Details window, enter a valid Sun Management Center
username and password and select Login. The Host Details window for whichever
host you selected (FIGURE 2-7).

FIGURE 2-7 Host Details Window
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Troubleshooting the Applications

TEC Adapter can’t successfully startup
■ Determine if the TEC server is running

■ Determine if the current port number is used.

■ Determine if the Tivoli environment has been set correct.y. To set the environment

correctly, type

. /etc/Tivoli/setup_env.sh

if running the Bourne shell, or type

source /etc/Tivoli/setup_env.csh

if you are running the C shell.

SyMONInt can’t successfully startup
■ Determine that TEC Adapter is running with the following commands:

ps - ef | grep tecad_symon
netstat -a | grep TEC_Adapter_port_number

■ Determine that the Sun Management Center server is running. The Sun

Management Center server’s version must be 2.1.

■ Determine that the Sun Management Center username and password are valid.

■ Determine that the JRE has been installed under /usr/java1.2/jre.

■ Determine that the Sun Management Center 2.1 console has been installed.

Sun Management Center alarms can’t transfer to

Tivoli
■ Determine that the TEC Adapter and the SyMONInt application are running

correctly.

■ Determine that the TEC server has been restarted after installation.
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■ Use the Tivoli wtdumpr1 and wtdumper commands to determine if events are

successfully reaching the Console. Depending upon how the time parameters for

receiving events are set, it is possible for old, Closed events to reach Tivoli but be

discarded because they’re Closed and older than the Tivoli server is set to accept.

Can’t run Sun Management Center Task Library
■ Determine that the current user has senior , user , and admin roles.

■ Check the xhost permissions for displaying the task from the Tivoli server to the

admin machine.

■ If you encounter permissions problems when running the task, check the

following:
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1. Double-click on the icon of the appropriate Policy Region in which the Sun
Management Center task library was installed (FIGURE 2-8) to display the Policy
Region the window(FIGURE 2-9).

FIGURE 2-8 Select Policy Region
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2. Double-click on the SunMC Task Library icon.

FIGURE 2-9 Select SunMC Task Library
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3. Double-click on the SunMC Task Library icon to display the Task Library window
(FIGURE 2-10). Right-click on the HostDetails icon and select Edit Task to display
the Edit Task window (FIGURE 2-11).

FIGURE 2-10 Get HostDetails Icon
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4. Determine that Roles Required have admin, senior, and super selected, and that
there is an asterisk ‘*’ in both the User Name and Group Name fields (these
should already be set, so you should not need to change anything).

FIGURE 2-11 Edit Task

5. Click Change&Close to return to the task.
40 Sun Management Center-Tivoli TEC Adapter Installation Guide • November 1999



Can’t launch Hostdetail window

Refer to Sun Management Center troubleshooting.
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